
Internet Explorer 4.01 Accessibility 


Microsoft Internet Explorer is a powerful web browser that supports many features that aid people with disabilities. It is available at no charge and is ready for download.

Microsoft Internet Explorer 4.01 for Windows introduces a number of advances that make the World Wide Web more accessible to computer users with disabilities. In particular, several features allow you to customize the appearance of Web pages to meet your own needs and preferences. It also includes the best features of Internet Explorer 3.0, including the ability to navigate the Web using the keyboard.

However, because of significant changes in architecture between Internet Explorer 4.01 and Internet Explorer 3.0, accessibility aids written for version 3.0 may not work as well with version 4.01. Before upgrading to version 4.01 you should understand the specific places where its behavior differs from version 3.0. In some cases you may want to disable specific features in Internet Explorer in order to render it more accessible, or even continue using version 3.0 until further advances are made.

If you have Internet Explorer 4.0 for Windows, Internet Explorer 4.0 for Unix, Internet Explorer 4.0 for Mac or Internet Explorer 4.0 for Windows 3.1 read “Differences Between Internet Explorer 4.0 and 4.01” for important information on the accessibility features available in these versions.
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Accessibility overview

Microsoft is committed to making computers easier to use for everyone, including individuals with disabilities. In recent years Microsoft has established close relationships with users who have disabilities, organizations representing such individuals, workers in the rehabilitation field, and software developers who create products for this market. Internet Explorer 4.01 includes many new features that benefit users with disabilities. Among the most important new features are:

· Take control over how Web pages are displayed. You can choose the colors, font sizes, and font styles for all the Web pages you view. Install your own style sheet, which gives you great control over how documents are formatted on the screen…you can even can make headings larger, or highlight italicized text with a different color. Turn off all animations or just stop them temporarily. Any feature you choose for Web pages can also be used with your desktop, Explorer, and Help. Users who like large fonts can also take advantage of the new scrolling menus, which let you use large menus without having them running off the screen.

· Work better with screen readers and other accessibility aids. Authors can now add important new information to their Web pages, such as user-friendly names for frames, links within images…just about anything. Active Accessibility enables screen readers to navigate tables and frames and read them to the user in the proper order. You can turn off smooth scrolling and other effects that can confuse screen reading utilities. The Dynamic HTML Object Model makes possible exciting new classes of add-on utilities for Internet Explorer. Some, such as the Internet Explorer PowerToys, provide important features for users with disabilities. (See www.microsoft.com for installation information about PowerToys) When Internet Explorer4.01 detects a screen reader, it now appends text to checkboxes in treeviews that can be read aloud to verify if boxes are checked or unchecked.

· Reduce the amount of memory and typing required. AutoComplete finishes typing long and complicated URL's. Explorer Bars for Search, History, Favorites, and new Channels make it easier to find the things you need, things you’ve seen, or things you visit most often.

· Customize the layout to make it easier to perform the tasks you need. The Windows Desktop Upgrade, an optional feature of Internet Explorer 4.01, allows you to further customize your desktop and Start menu. Choose from a range of desktop toolbars, or even create your own.

· Get better feedback. Optional sounds to let you know when pages begin and finish loading. You can also change the appearance of links when activating them or moving over them with the mouse.

· Easier to use with the mouse. You can also choose to single-click instead of double-clicking for the most common operations. Put the most commonly used commands and shortcuts on desktop toolbars where they are always one click away.

· Communicate. Microsoft NetMeeting represents a powerful tool for individuals who are deaf or hard-of-hearing to communicate and collaborate more effectively in real-time through the use of Internet conferencing capabilities on the Internet, corporate intranet, or school network.

In addition, features carried over from version 3.0 include:

· Navigate with the keyboard through documents, panes, links, and other controls.

· Replace images with textual descriptions.
· Turn off pictures, videos, and sounds.
· Use the High Contrast option in Windows to choose a simple color scheme and omit images that make text difficult to read.

Deciding whether to upgrade

Warning  Before upgrading to Internet Explorer version 4.01, you should understand the specific places where its behavior differs from version 3.0. In some cases you may want to disable specific features in Internet Explorer in order to render it more accessible, or even continue using version 3.0 until further advances are made. Contact the vendor of your adaptive aids to find out how they work with Internet Explorer 4.01. Aids are updated often and a newer version might work better.

· Internet Explorer 4.01 allows you to navigate through links using the tab key, just as you did in versions 3.0 and 4.0. However:

· Internet Explorer 4.01 always starts navigating with the first link on a page. Version 4.0 would start at the location currently being displayed.

· When returning to a previously visited page, Internet Explorer 4.0 and 4.01 reset the keyboard focus to the beginning of the page. The page is still displayed from the point of departure, which may be a different screen than that which has the keyboard focus.

· Version 4.0 and 4.01 will allow navigating to objects that are not currently visible on the screen. This may result in the keyboard focus appearing to “disappear” at times. Simply pressing the tab key additional times will usually bring it back into view.

· When viewing a form, the keyboard focus is not automatically on the first entry field is it was in Internet Explorer 3.0.

· Users who need to keep as many options as possible on the screen at one time, and who have many commands on their Start menu, may want to avoid using the Windows Desktop Update. This option replaces the Start menu with a scrolling menu, which limits the number of menu commands visible at one time to those that fit in a single column.

· Some ActiveX controls may be inaccessible to the keyboard.
· Internet Explorer 4.01 uses a different keyboard equivalent to right-clicking on a document, so the shortcut menu is displayed. In version 4.0 you pressed tab to navigate to the page, then pressed shift+f10. In Internet Explorer 4.01 you press shift+f10 when the page is first displayed. After you navigate within the page using the tab key, you must press f5 to reload the page before you can display the shortcut menu.
· When using the arrow keys to navigate lists in the Explorer bar, items off the end of the screen do not always scroll into view.

Suggested features by disability

The following lists are suggestions of features that may be useful to users with certain types of disabilities. These lists are not complete, as the needs of individuals vary, as do their preferences, and many people have a combination of disabilities or differing abilities. Users without disabilities will also be interested in many of these options as ways to customize colors and fonts to their own taste, as will users who want to use keyboard shortcuts to save time.

Features for users who are blind

Many users who are blind use “screen readers”–assistive software that can provide a spoken or Braille description of windows, controls, menus, images, text and other information typically displayed visually on a screen. Internet Explorer 4.01 uses the new HTML 4.0 standard, which lets Web page designers add additional information that is useful to blind individuals, such as the name of an image or control. You can turn off Smooth scrolling if it causes your screen reader to function improperly. You can also turn off many multimedia options to save time downloading. Two new sound events, Start Navigation and Complete Navigation have been added to the Sounds Control Panel to signal when a page starts downloading and when it is finished.

The following are specific features that can benefit users who are blind:

Keyboard:

· Use Keyboard navigation in Internet Explorer (See page 9)

· Use Keyboard navigation in the Active Desktop (See page 23)

· Use Keyboard navigation of Internet Explorer 4.01 Help (See page 25 ref IE4helpkeyboard \* Mergeformat )

· Use Keyboard navigation in NetMeeting (See page 30)

Through the Accessibility box on the General tab in Internet Options (See pageref accessibilitybox \* Mergeformat  12):

· Select Ignore colors specified on Web pages

· Select Ignore fonts styles specified on Web pages
· Select Ignore font sizes specified on Web pages
· Select Format documents using my style sheet.

Through the Advanced tab in Internet Options (See page 19):

· Select Accessibility: Always expand alt text for images
· Select Accessibility: Move system caret with focus/selection changes

· Clear Use smooth scrolling.

· Clear Multimedia: show pictures
· Clear Multimedia: play animations
· Clear Multimedia: play videos
· Clear Smart image dithering
Through the Sounds Properties box in Control Panel:
· Assign a sound to Complete Navigation
· Assign a sound to Start Navigation
Features for users with low vision

Common forms of low vision are color blindness, difficulty in changing focus, and impaired contrast sensitivity. Users with color blindness may have difficulty reading colored text on a colored background. Users who have difficulty changing focus or who experience eye strain with normal use of a video display may have difficulty reading small text, discriminating between different font sizes or using small onscreen items as targets for the cursor or pointer. Users with impaired contrast sensitivity may have difficulty reading black text on a gray background.

Internet Explorer 4.01 provides features to customize the colors of background, text, and links; to control the display of fonts by size and face; and to display Web pages using the High Contrast color schemes available in Windows. If you are using magnification software or hardware, you can use keyboard shortcuts make the selection of onscreen elements easier than it would be using the mouse. When Internet Explorer 4.01 Sound Pack is installed, two new sound events, Start Navigation and Complete Navigation are added to the Sounds Control Panel to signal when a page starts downloading and when it is finished.

The following are specific features that can benefit users who have low vision:

Keyboard:

· Keyboard navigation in Internet Explorer (See page 9)

· Keyboard navigation in the Active Desktop (See page 23)

· Keyboard navigation in Internet Explorer Help (See page 25)

· Use Keyboard navigation in NetMeeting (See page 30)

Through the Accessibility box on the General tab in Internet Options (See page 11):

· Select Ignore Colors specified on Web pages
· Select Ignore fonts styles specified on Web pages
· Select Ignore Font sizes specified on Web pages
· Select Format documents using my style sheet
Through the Colors box on the General tab in Internet Options (See page 11):

· choose Text and Background colors for Web pages (or create custom colors)

· choose Visited and Unvisited colors for links (or create custom colors)

or
·  Select Use Windows colors to display Web page elements using the window colors selected through the Display icon of Control Panel.

Through the Advanced tab in Internet Options (See page 19):

· Select Accessibility: Always expand alt text for images

· Select Accessibility: Move system caret with focus/selection changes

· Clear Print background colors and images

· Select Show font button

· Clear Small icons
Through Sounds Properties box in Control Panel:
· Assign a sound to Complete Navigation
· Assign a sound to Start Navigation
Features for users who are deaf or hard-of-hearing

Sound cues in applications are not useful to users with hearing impairments or users working in a noisy environment. Control Panel in Windows provides visual feedback to substitute for common sound events (such as the "beep" to signal an invalid keystroke). Internet Explorer 4.01 allows you to turn off the default downloading of sound files. You can use NetMeeting as a collaboration application locally as well as across the Internet. When Internet Explorer 4.01 is installed, two new sound events that can be customized, Start Navigation and Complete Navigation, are added to the Sounds Control Panel to signal when a page starts downloading and when it is finished.

Users who are deaf may have sign language as their primary language and English as their secondary language. They may have difficulty reading pages that use custom fonts, depart from typographical convention such as mixing upper and lower case letters or use animated text displays. In addition to customizing the display of sound events, these users may also be interested in the features Internet Explorer 4.01 provides for users with cognitive or language impairments (See page 8).

The following are specific features that can benefit users who are deaf or hard-of-hearing:

· Integrate NetMeeting (See page 28)

Through the Accessibility Properties in Windows Control Panel:

· Select Sound Sentry
Through the Advanced tab in Internet Options (See page 19):

· Clear Multimedia: Play sounds
Features for users with physical impairments

Some users are unable to perform certain manual tasks, such as using a mouse or typing two keys at the same time. Others may have a tendency to hit multiple keys, “bounce” fingers off keys, or be unable to hold a printed book. Many users need keyboards and mouse functions to be adapted to their requirements, or rely exclusively on a single input device. Internet Explorer 4.01 makes it easier for you to enter long or repetitive URL’s with the AutoComplete option, or customize any of the four Explorer bars (History, Favorites, Search and Quicklinks). You can add shortcut keys and URL's to the Start menu under Active Desktop. Enlarge buttons and the text of links to makes them easier to target with the mouse, and with a hover color selected targeted inks will be displayed in a color you can specify. You can also choose to have "hovered" links underlined. In a new industry standard, Internet Explorer 4.01 allows you to take advantage of shortcut keys assigned to dialog boxes in pages written in HTML 4.

The following are specific features that can benefit users with physical impairments:

Keyboard:

· Use Keyboard Navigation and Shortcuts (See page 9)

· Use Keyboard navigation in the Active Desktop (See page 23)

· Use Keyboard navigation in Internet Explorer Help (See page 25)

· Use Keyboard navigation in NetMeeting (See page 30)

· Use AutoComplete (See page 10)

· Use Explorer bars (See page 23)

· Use Channels through the Start menu or through the Active Desktop channel bar

Through the Accessibility box on the General tab in Internet Options (See page 12):
· Select Ignore Font sizes specified on Web pages
· Select Format documents using my style sheet
Through the Colors box on the General tab in Internet Options (See page 11):

· Select Use hover color
Through the Advanced tab in Internet Options (See page 19):

· Select Accessibility: Always expand alt text for images

· Select Accessibility: Move system caret with focus/selection changes

· Select Use AutoComplete
· Select Underline links: Hover

· Select Toolbar: Show font button
· Clear Toolbar: Small icons
Features for users with seizure disorders

Users with seizure disorders (such as epilepsy) may be sensitive to screen refresh rates, blinking or flashing images, or specific sounds. Settings in Internet Explorer 4.01 can prevent the default loading of animations, videos, and sounds. You can also assign custom sounds to any event using Windows Control Panel.

NOTE  If RealAudio is installed, or if a movie is playing, sound might play even if you clear the Play sound check box.

NOTE  Scripts and applets within Web pages can play animations, videos, or sounds on their own, regardless of any settings you choose in Internet Explorer.

The following are specific features that can benefit users who have seizure disorders:

Keyboard Shortcut (See page 9):

· Use the esc key to turn off animations.

 Through the Advanced tab in Internet Options (See page 19):

· Clear Multimedia: Play animations
· Clear Multimedia: Play videos
· Clear Multimedia: Play sound
Features for users with cognitive and language impairments

Cognitive impairments take many forms, including short- and long-term memory loss, perceptual differences, and developmental disabilities. Language impairments, such as dyslexia or illiteracy, are also very common. Even people learning the language used by their computer software as a second language can be considered to have a form of language impairment.

Internet Explorer 4.01 makes it easier for you to enter long or repetitive URL’s with the AutoComplete option, or customize any of the four Explorer bars (History, Favorites, Search and Quicklinks). You can add shortcut keys and URL's to the Start menu under Active Desktop. You can launch the browser in full-screen which removes all toolbars and scrollbars from the screen. This allows users with cognitive disabilities to be able to have more information on the screen at one time or to remove distractions from peripheral controls. Use the Thumbnails view to look at multiple Web sites or multiple graphic files at the same time. Internet Explorer 4.01 offers many ways to highlight certain types of information, such as links or headings, and to change formatting that might distract from the content of the document, such as custom fonts, images, animated gifs, background colors or background bitmaps.

The following are specific features that can benefit users with cognitive or language impairments:

· Use Keyboard Navigation and Shortcuts. (See page 9)

· Use Keyboard navigation in the Active Desktop (See page 23 )

· Use Keyboard navigation of Internet Explorer Help (See page 25)

· Use Keyboard navigation in NetMeeting (See page 30)

· Use AutoComplete. (See page 10)

· Use Explorer bars

· Use Channels through the Start menu or through the Active Desktop channel bar

· Switch between full-screen and windowed displays by pressing the f11 key

Through the Accessibility box on the General tab in Internet Options (See page 11):

· Select Ignore Colors specified on Web pages
· Select Ignore fonts styles specified on Web pages
· Select Ignore Font sizes specified on Web pages
· Select Format documents using my style sheet
Through the Colors box on the General tab in Internet Options (See page 16):

· Choose Text and Background colors for Web pages (or create custom colors)

· Choose Visited and Unvisited colors for links (or create custom colors)

 
or
· Select Use Windows colors to display Web page elements in High Contrast mode through Control Panel

· Select Use Hover color

Through the Advanced tab in Internet Options (See page 19):

· Select Accessibility: Always expand alt text for images

· Select Accessibility: Move system caret with focus/selection changes

· Select or clear Browsing: Launch Channels in full screen window

· Select or clear Browsing: Launch browser in full screen window
· Select Browsing: Use AutoComplete
· Select Browsing: Show friendly URLs
· Clear Multimedia: show pictures
· Clear Multimedia: play animations
· Clear Multimedia: play videos
· Clear Browsing: Use smooth scrolling
· Clear Printing: Print background colors and images
· Select Toolbar: Show font button
· Clear Toolbar: Small icons
On the Internet Explorer toolbar:

· Customize the Toolbar through the View menu

Internet Explorer

Keyboard access

One of the most important accessibility features is the ability to use the keyboard, because it affects people with a wide range of disabilities. This section describes:

· Internet Explorer 4.01 keyboard quick reference

· Keyboard navigation of Web pages

· AutoComplete shortcut keys

Internet Explorer 4.01 keyboard quick reference

You can use shortcut keys to move between screen elements, choose commands, and view documents.

	To:
	Press:

	Move forward between links and the Address, Link, and Explorer Bars
	tab

	Move back between links and the Explorer, Links and Address Bars
	shift+tab

	Activate a selected link
	enter

	Display a shortcut menu for the page, or a link after pressing tab
	shift+f10

	Go to previous page
	alt+left arrow

	Go to next page (after having used alt+left to go backwards)
	alt+right arrow

	Move forward between frames and the Address, Links, and Explorer Bars
	ctrl+tab

	Move back between frames and the Explorer, Links, and Address Bars
	shift+ctrl+tab

	Scroll toward the beginning of a document
	up arrow

	Scroll toward the end of a document
	down arrow

	Scroll toward the beginning of a document in larger increments
	page up or shift+space bar

	Scroll toward the end of a document in larger increments
	page down or space bar

	Move to the beginning of a document
	home

	Toggle full-screen display of a document
	f11

	Move to the end of a document
	end

	Refresh the current page
	f5

	Stop downloading a page and stop animation
	esc

	Go to a new location
	ctrl+o

	Open a new window
	ctrl+n

	Save the current page
	ctrl+s

	Print the current page or active frame
	ctrl+p


For additional information about using Windows with the keyboard, see the Microsoft Windows Keyboard Guide, which is available from our Web site, http://microsoft.com/enable.

Keyboard navigation of Web pages

You can move forward and backward between the Address bar and links using tab and shift+tab. A one-pixel-wide border appears around links so you can see what is selected.

When a page is first displayed, you can display the shortcut menu for this page by pressing shift+f10. After you have pressed tab to navigate to a link, you must reload the page by pressing f5 before displaying the shortcut menu.

The selection rotates forward through the screen items on the displayed Web page in this order:

1. The current address (URL) in the Address bar.

If the Address bar is not displayed, you may not see any focus box on your screen.

To display the Address bar, choose the Address command in the View Toolbars menu.

2. The Links bar

As the Links bar is not displayed by default, you may not see any focus box on your screen.

To display the Links bar, choose the Links command in the View Toolbars menu.

3. The Explorer bar

If the Explorer bar is open, you will see an entry highlighted on the bar.

To display the Explorer bar, from the View menu choose the Explorer Bar menu.

Choose the Explorer Bar you want from Search, Favorites, History, Channel, or None.

2. Links on the page in left-to-right then down order

· As links are highlighted, the link’s URL appears on the message bar.

· Press enter to activate the link

· Press shift+f10 to open a shortcut menu for the link

3. The highlight returns to the Address bar.

Note  Web page designers may specify a different order for their links than the standard left-to-right and top-to-bottom order.

You can use shift+tab to move between the same areas, but in reverse order. However, the focus stops on the page as a whole before reaching the links on the page, whether traveling in forward or reverse direction. When using shift+tab, the focus moves in the following order:

1. The current address (URL) in the Address bar.

2. The page as whole

3. Links on the page in right-to-left, then upwards order

4. The Explorer bar

5. The Links bar

6. The highlight returns to the Address bar.

You can quickly skip to the next frame by pressing ctrl+tab, or to the previous frame by pressing ctrl+shift+tab. These behave exactly like tab and shift+tab, except that they skip all remaining links in the current frame.

AutoComplete shortcut keys

The Address bar in Internet Explorer 4.01 automatically completes addresses for you, based on sites you've already visited or files on your local machine. You can easily override the suggestions by typing over them. AutoComplete makes it easier for you to type in URL's and reduces the opportunity to make mistakes by filling in long URL's automatically. It also adds prefixes and suffixes to Internet addresses. Turn on Use AutoComplete through the Advanced tab in Internet Options (See page 19).

AutoComplete also includes the following shortcuts. You can:

· To add to the string that has been automatically completed, press right arrow and then type the additional characters.

· Skip to break or separation characters in URL's (such as \) by pressing and holding ctrl, and then using the left arrow or right arrow keys.

· Search your history file by typing the beginning of an address and then pressing the up arrow or down arrow keys to complete it.

· Enter a partial URL, then press ctrl+enter to add "http://www." before the entry and ".com" after it.

If you install the Windows Desktop Update, AutoComplete will also work when using the Run command from the Start menu.

Customizing display of fonts and colors

When Web authors and designers create Web pages, they often specify particular font colors and sizes, typefaces, and background colors. These settings may be specified for each item as it is coded on the Web page, or it may be defined in a “style sheet,” which is a type of template for specifying how different styles should appear throughout a Web page or site. Internet Explorer 4.01 lets you override any or all of these settings.

You can specify your font and color preferences, so that Internet Explorer uses your preferences for all pages. You can also override formatting with your own style sheet or using the High Contrast options found in Windows Control Panel under Accessibility.

To immediately display text larger or smaller while viewing a page

1. Click the Font button on the toolbar
or

On the View menu, choose Fonts
2. Choose the size you want.



A check appears next to your choice and the change immediately takes effect.



Changes made with the Font button or View Fonts only affect pages displayed during your current session.



Note Because of the different ways that pages can be formatted, some pages cannot be displayed larger or smaller fonts using this option. To change the appearance of such pages, see “To override page formatting” on page 12.

If there is no Font button on the Toolbar:
1. On the View menu in Internet Explorer, choose Internet Options

or

In the Control Panel in Windows, select the Internet icon.

The Internet Options box appears

2. Select the Advanced tab.

A checklist tree of options appears.

3. Select Toolbar:Show font button
4. Choose OK.
If there is still no font button on the Toolbar:

1. Open the View menu

2. Choose Toolbars
3. Select Text Labels

When checked, Text Labels adds text labels to the Toolbar buttons, making the buttons larger but pushing some buttons off the screen. When unchecked, the Toolbar buttons are smaller and all fit on the Toolbar.




Internet Options box

To override page formatting

1. On the View menu in Internet Explorer, choose Internet Options

or

2. In the Control Panel in Windows, select the Internet icon.

The Internet Options box appears.

3. On the General tab, select Accessibility
The Accessibility box appears.

4. Select any of the following you want:

· Ignore Colors specified on Web pages

· Ignore font styles specified on Web pages

· Ignore font sizes specified on Web pages

· Format documents using my style sheet

· Choose your style sheet from the listbox.

· You can browse for Style sheets.

5. Choose OK




Accessibility box

Sample Style Sheet for users with low vision

The following is a sample style sheet which adjusts the display of Web pages and help topics to be more easily read by users with certain types of low vision.

This example shows a style sheet that can be used with Internet Explorer 4.01. It demonstrates a few of the features in Internet Explorer 4.01 that can make pages easier to read for users with low vision. In particular, it overrides normal formatting of all displayed pages in the following ways:

· Everything appears in high contrast, with a black background and brightly colored text. Body text is white, highlighted text is yellow, and links are brighter versions of their normal blue and purple.

· All text is displayed large and in a plain, sans-serif font. Body text is 24 point and headings are 32 point.

· All bolding, italics, and underlining are replaced by a single highlight color. That is because each of those formatting options is actually less legible than normal text.

· The keyboard focus is emphasized by showing the active link in a bright, light green, sometimes called "low vision green."

These settings will affect all pages viewed in Internet Explorer, as well as pages displayed by other programs (such as HTML Help) using MSHTML.DLL.

BODY, TABLE {

        font-size:
24pt;

        font-weight:
normal;

        font-family:
sans-serif;

        background:
black;

        color:

white;

     }

B, I, U { color: yellow; font-weight: normal; font-style: normal; }

H1 { font-size: 32pt; }

H2 { font-size: 32pt; }

H3 { font-size: 32pt; }

H4 { font-size: 32pt; }

H5 { font-size: 32pt; }

H6 { font-size: 32pt; }

a:visited
{color: #FF00FF}

a:link
{color: #00FFFF}

a:active
{color: #B1FB17}




Sample Page Displayed using the Sample Style Sheet 

To display Web pages in high-contrast color scheme: 
1. Set High Contrast through the Windows Control Panel Accessibility option

2. Turn off colors, font styles, and font sizes specified on Web pages

3. Turn on Use Windows Colors
4. Refresh page if necessary. In some cases it may be necessary to restart Internet Explorer.




Sample Page Displayed in High Contrast Mode
To display text in a different font

1. On the View menu in the browser, choose Internet Options.

2. On the General tab, choose Fonts.

The Fonts box appears.

3. Select the character set of your choice.

Fonts will appear in the drop-down list boxes

4. Select the fonts of your choice.

5.  Choose OK.

Note Because of the different ways that pages can be formatted, some pages will not be affected by this option. To change the appearance of such pages, see “To override page formatting” on page 12.

To change text and background colors

1. On the View menu in Internet Explorer, choose Internet Options
or
In the Control Panel in Windows, select the Internet icon.

The Internet Options box appears.

2. On the General tab, select Accessibility
The Accessibility box appears.

3. Select Ignore Colors specified on Web pages
4. Choose OK.
5. On the View menu in the browser, choose Internet Options.

6. On the General tab, choose Colors.

7. In the Color box, choose the Text or Background button.

A palette appears of available colors.

8. Select the color of your choice.

9. Choose OK.

Note Because of the different ways that pages can be formatted, some pages will not be affected by this option. To change the appearance of such pages, see “To override page formatting” on page 12.

To change link colors

1. On the View menu in Internet Explorer, choose Internet Options
or
In the Control Panel in Windows, select the Internet icon.

The Internet Options box appears.

2. On the General tab, select Accessibility
The Accessibility box appears.

3. Select Ignore Colors specified on Web pages
4. Choose OK.
5. On the View menu in the browser, choose Internet Options.

6. On the General tab, choose Colors.

7. In the Colors box, choose the Visited or Unvisited button.

A palette appears displaying available colors.

8. Select the color of your choice.

9. Choose OK.

Note Because of the different ways that pages can be formatted, some pages will not be affected by this option. To change the appearance of such pages, see “To override page formatting” on page 12.




The Colors box

To customize hover colors

1. On the View menu in Internet Explorer, choose Internet Options

or
In the Control Panel in Windows, select the Internet icon.

The Internet Options box appears.

2. On the General tab, select Accessibility
The Accessibility box appears.

3. Select Ignore Colors specified on Web pages
4. Choose OK.
5. On the View menu in the browser, choose Internet Options.

6. On the General tab, choose Colors.

7. In the Colors box, check the Use hover color box.
The Hover button will be enabled with the default color.

8. Choose the Hover button.

A palette appears of available colors.

9. Select the color of your choice.

10. Choose OK.

Note  Because of the different ways that pages can be formatted, some pages will not be affected by this option. To change the appearance of such pages, see “To override page formatting” on page 12.

To Create Custom Colors for pages, links, and hovered links:

1. On the View menu, choose Internet Options.

2. On the General tab, choose Colors.

3. In the Color box, choose Define Custom Colors.

The color palette expands.

1. Enter the values of your choice in any of the Hue, Sat, Lum, Red, Green and Blue boxes. The sample box changes color to reflect your choice.

2. Select Add to Custom Colors.

The new color appears in the Custom Colors palette.

1. Choose OK.

Tip—how font size changes are applied in Internet Explorer 4.01

Here is the correct order in which various factors affecting font size are applied when the browser displays a page:

1. The Internet Explorer 4.01 built-in defaults (e.g. P is size 3, H1 is size 6, etc.).

2. A user-specified style sheet - if one is provided and Format documents using my style sheet is checked.

3. Style sheet information in the document - unless Ignore font sizes specified on Web pages is checked

4. FONT tags in the document - unless Ignore font sizes specified on Web pages is checked.

5. Multiplying by a scaling factor determined by the View Font option - except in those cases where the font is specified in an absolute size such as 12pt.

Notes:

· The scaling factor used in step 5 can be set in either of two ways: View Option Fonts Size changes the default for current and future sessions, whereas changing View Fonts changes it for the current session only.

· FONT tags and style sheets can specify font size either (a) as an index value (1-7) or (b) as a relative value (e.g. +1, BIGGER, or 120%) or (c) as an absolute size (e.g. 12pt, .25in). The first two are affected by the scaling factor applied in step 5, but the third is not.

· Relative font sizes applied in the document or style sheet are not cumulative. Applying two "+1" is the same as applying one "+1" not the same as applying "+2".

Here are some implications of that:

· The Ignore font sizes specified on Web pages option ignores all font sizes specified by FONT tags or style sheets, but it does not override relative sizes that are implied by structural tags. For example, H1 will automatically be size 6 instead of the P size 3 even when Ignore Font Sizes is turned on.

· In order to get sizes in the User Style Sheet to override those in the document, you must turn on Ignore font sizes specified on Web pages option to skip steps 3 and 4.

Some examples of how font sizing is applied:

A document uses FONT tags to set a certain section of paragraph text to 20 points in size. The user has chosen Large size from the View Fonts menu. The following actions take place:

1. Internet Explorer applies its default formatting for paragraph text, making size 3, which is equivalent to 12pt.

2. There is no user-supplied style sheet, so the formatting is not changed.

3. There is no style sheet in the Web page, so the formatting is not changed.

4. The FONT tag formatting is applied, overriding the build-in defaults and setting the size to 12pt.

5. Since the font size has been specified as a point size, the setting chosen from the View Fonts menu is ignored, and the font is left at 12pt.

If the user turns on the Ignore font sizes specified on Web pages option, step four will be ignored:

1. Internet Explorer applies its default formatting for paragraph text, making it size 3, which is equivalent to 12pt.

2. There is no user-supplied style sheet, so the formatting is not changed.

3. Since the Ignore font sizes specified on Web pages option has been selected, any style sheet formatting in the document would be ignored, and the font size remains at size 3.

4. Since the Ignore font sizes specified on Web pages option has been selected, the FONT tag formatting is ignored, and the font size remains size 3.

5. Since the font size has been specified as a numeric value rather than a point size, the setting chosen from the View Fonts menu is used. The Medium setting causes the font to be magnified by 50%. It changes from size 3 (equivalent to 12 pt) to the equivalent of 18pt.

If the user turns on the Format documents using my style sheet option, and the style sheet sets paragraph text to size 24pt:

1. Internet Explorer applies its default formatting for paragraph text, making it size 3, which is equivalent to 12pt.

2. The user-supplied style sheet overrides the normal paragraph formatting and sets the text to 24pt.

3. Since the Ignore font sizes specified on Web pages option has been selected, any style sheet formatting in the document would be ignored, and the font size remains at 24pt.

4. Since the Ignore font sizes specified on Web pages option has been selected, the FONT tag formatting is ignored, and the font size remains 24pt.

5. Since the font size has been specified as a point size, the setting chosen from the View Fonts menu is ignored, and the font size remains 24pt.

Customizing other Internet Options

Most Accessibility features (other than customizing fonts and colors) are displayed in a checklist through the Advanced tab of the Internet Options Box under View or through the Advanced tab of the Internet icon in Control Panel.

1. On the View menu in Internet Explorer, choose Internet Options

or
2. In the Control Panel in Windows, select the Internet icon.

The Internet Options box appears.

3. Select the Advanced tab.

A checklist tree of options appears.

· Use tab to move to the first option in the list.

· Use the up arrow and down arrow keys to move through your selections.

· Use the right and left arrow keys to open or close groups of related options.

· Use the space key to select and deselect the options you want.

4. Choose OK.

Caution  Using the space key to select and deselect options causes a beep as if you had entered an incorrect keystroke.




Internet Options box

The following options are useful for accessibility:

Accessibility: Always expand alt text for images

Specifies whether the image size should expand to fit all of the alternate text when the Show Pictures check box is cleared.

Accessibility: Move system caret with focus/selection changes

Specifies whether to move the system caret whenever the focus or selection changes. Some accessibility aids, such as screen readers or screen magnifiers, use the system caret to determine which area of the screen to read or magnify.

Browsing: Launch Channels in Full Screen Window

Specifies whether to automatically display Channels in full screen mode. This can be done more easily through the View menu. Use f11 to toggle out of full screen mode.

Browsing: Launch browser in full screen window

Specifies whether to automatically display Web pages in a full screen whenever you start Internet Explorer. This removes all toolbars and scrollbars from the screen to make more room for Web pages. This allows users with cognitive disabilities to be able to have more information on the screen at one time or to remove distractions from peripheral controls. This is also useful if you are using large fonts or don't want to scroll as often. Use f11 to toggle out of full screen mode.

Browsing: Use AutoComplete

Specifies whether you want Internet Explorer to automatically complete Internet addresses as you type them in the Address bar. If you’ve visited the Web site before, the AutoComplete feature suggests a match as you type. Some users with cognitive disabilities may want to turn this off to avoid distractions, and some users of blind-access utilities may want to turn it off if their accessibility aid reads the suggestions as they appear, making typing difficult. (See page 10)

Browsing: Show friendly URLs

Specifies whether you want Internet Explorer to show the full Internet address (URL) for a page on the status bar.

Browsing: Use smooth scrolling

Specifies whether scrolling is used gradually slide information up or down the screen when the user clicks on the scroll bar or presses navigation keys such as page down. Some users of blind-access utilities may want to turn this off if it causes timing problems. People with certain cognitive disabilities may want to turn it off because they find the motion distracting.

Browsing: Underline links

Specifies how you want links on Web pages underlined. Select one of the following settings:

· To underline all links, select Always
· To not underline links, select Never
· To underline links when your mouse pointer is over the link, select Hover
You can may prefer to indicate whether or not a link is "hovered" by a change in color (see page 17). Older blind-access utilities rely on underlines to recognize links.

Multimedia: Show pictures

Specifies whether graphical images should be included when pages are displayed. ALT text (descriptive text) is displayed in place of the graphic if supplied by the page.

When this check box is cleared, you can still display an individual image by right-clicking the icon that represents the graphic and then clicking Show Picture. (There is currently no keyboard equivalent for this.)

Turning off images can allow older blind-access utilities to read the textual description for these images aloud, however newer utilities can use Microsoft Active Accessibility to identify and read these descriptions even when the graphics are still displayed on the screen. Many users prefer to turn off images as it speeds up access to the Web considerably, and saves hard-drive space. If images are turned on or the textual description is cut off by space limitations, you can see the full description by moving the mouse over the image.

Multimedia: Play animations

Specifies whether animations can play when pages are displayed. ALT text (descriptive text) is displayed in place of the graphic if supplied by the page.

When this check is cleared, you can still play an individual animation by right-clicking the icon that represents the animation and then clicking Show Picture. (There is currently no keyboard equivalent for this.)

In addition to users who are blind, users with seizure disorders may want to turn off animation (especially blinking). Users with cognitive disabilities may want to turn off animations or selectively download them to prevent distractions. Many users prefer to turn off animation as it speeds up access to the Web considerably, and saves hard-drive space

Multimedia: Play videos
Specifies whether video clips can play.

When this check box is cleared, you can still play an individual video by right-clicking the icon that represents the animation and then clicking Show Picture. (There is currently no keyboard equivalent for this.)

In addition to users who are blind, users with seizure disorders may want to turn off video. Users with cognitive disabilities may want to turn off videos or selectively download them to prevent distractions. Many users prefer to turn off videos as it speeds up access to the Web considerably, and saves hard-drive space.

Multimedia: Play sounds
If RealAudio is installed, or if a movie is playing, sound might play even if you clear this check box.

In addition to users who are deaf-or-hard of hearing, users with seizure disorders may want to turn off sound. Users with cognitive disabilities may want to turn off sounds or selectively download them to prevent distractions. Users who are blind may want to turn off sounds or selectively download them so that they do not conflict with the screen reader reading aloud text. Many users prefer to turn off sounds as it speeds up access to the Web considerably, and saves hard-drive space.

Printers: Print Background Colors and Images

Specifies that you want Internet Explorer to print background colors and images when you print a Web page.

Users with low vision or those wanting to speed up print time may want to turn this off. You will also want to turn this off if you are preparing text to be scanned, for example to provide it to a text reader.

Toolbar: Show font button
Specifies whether to display the Font button on the toolbar. You can use this button to immediately change the size of fonts displayed on a page you are currently viewing.

Note If the Font button does not appear on your tool bar when this setting is enabled, it may be off the right edge of the screen. The Text Labels option adds text labels to the Toolbar buttons and makes the buttons larger, in some cases pushing some buttons off the screen. When unchecked, the Toolbar buttons are smaller and all fit on the Toolbar. To hide the text labels:

1. Open the View menu.

2. Choose Toolbars
3. Select Text Labels
Toolbar: Small icons

Specifies whether you want Internet Explorer to display the toolbar using Microsoft Office-style buttons. These buttons are smaller than the default buttons, and so users who prefer larger buttons should clear this option.

Active Desktop and the Windows Desktop Update

When you install Internet Explorer 4.01, you have the option of installing the Windows Desktop Update. This option affects the display of your desktop, the task bar, the Start menu, and the display of folders in the Windows Explorer.

Overview of Active Desktop and the Windows Desktop Update

Features included with this update include:

· The Start menu, and menus displayed by Explorer, are now custom scrolling menus. This allows you to have more menu commands than fit on the screen at one time, which is helpful for people who enlarge the menu fonts or customize their menu to have many commands.

· You have several new desktop toolbars to choose from. These include:

· The Address bar, which functions like the Run command on the Start menu

· The Links bar, which shows Web sites of general interest

· The Desktop bar, which shows the objects on your desktop

· The Quick Launch bar, which shows links to commonly used commands

· You can create your own desktop toolbars with commands you use frequently. See procedure below.

· The Channel Bar is now displayed on your desktop. You can remove it or add other desktop objects using the Display options in Control Panel.

· You can choose to make your desktop and folder look and act like Web pages, including the ability to activate objects with a single click, and select them simply by hovering the mouse over them. Adjust these and other options by opening any folder and choosing Folder Options from the View menu.

· You can now view any folder as a Web page. Open any folder and choose as Web Page from the View menu. If you don't like this view, you can switch back to any of the views provided by Windows, including Large Icons, Small Icons, and List views.

For more information on Active Desktop, see Help in Internet Explorer 4.01.

Keyboard navigation of the desktop
Press tab and shift+tab to move forward and backward between the Start button, desktop icons, the QuickLaunch bar, the Taskbar, and the Channel bar. A one-pixel-wide border appears around items so you can see what is selected. 

The selection rotates forward through the Active Desktop items in this order:

1. The Start button on the Taskbar.

2. The Quick Launch toolbar.

One of the Quick Launch icons appears selected.

· You can use the arrow keys to move among the program icons. Once the focus is on an icon, you can press ENTER to launch the applications, or press SHIFT+F10 to display the shortcut menu for the toolbar. (All the toolbars on the desktop share the same shortcut menu.).

· The arrow keys wrap, i.e., continuing to use the right arrow on the rightmost icon moves to the leftmost (first) icon.

4. The Taskbar.

· A selection will not appear on the Taskbar, but the focus is in fact there. Press SHIFT+F10 at this point to display the shortcut menu for the toolbar. (All the toolbars on the desktop share the same shortcut menu.).

· Press the right arrow key to select an application. You can press enter to display the selected application, or press shift+f10 to display the shortcut menu for that application.

· arrow keys move among the application buttons.

· The arrow keys wrap, i.e., continuing to use the right arrow on the rightmost icon moves to the leftmost (first) icon.

4. The Desktop icons.

· An icon on the desktop appears selected.

· Use arrow keys to move between the icons on the desktop. You can press enter to open the application or document, or press shift+f10 to display the shortcut menu for that icon.

· Press ctrl+space bar to select or deselect the current icon; when no icon is selected, you can press shift+f10 to display the shortcut menu for the entire desktop.

· The arrow keys do not wrap, i.e., continuing to use the left arrow on the leftmost selection does not move the focus and does not play an error sound.

5. The Channel bar.

· The topmost button on the Channel bar appears selected.

· Use arrow keys to move between the icons on the channel bar. Press enter to display a channel using Internet Explorer.

· The arrow keys do wrap, i.e., continuing to use the down arrow on the last selection moves to the top button.

· Note you can only reach the Channel bar by pressing tab. The Channel bar is skipped when you navigate in reverse order using shift+tab.

6. The selection box returns to the Start button

If you add other bars, such as the Address bar, Quicklinks bar, Desktop bar, or a New Toolbar you can also use tab and shift+tab to navigate to these bars.

Customizing Desktop Toolbars

You can create your own desktop toolbars with commands you use frequently. This is most useful for people who prefer to use the mouse rather than the keyboard; users who prefer the keyboard will usually want to add commands to their Start menu instead.

To create a custom desktop toolbar:

1. Create a folder with the appropriate documents, shortcuts, or programs.

2. Display the shortcut menu for the taskbar by right-clicking on the taskbar, or by pressing ctrl+esc, esc, and tab, then pressing shift+f10.

3. Choose the Toolbar command, then the New Toolbar command.

4. Enter the path to the appropriate folder, or select the folder from the displayed list. You can press right arrow to display all the folders in a branch.

5. Choose OK.

· The new toolbar appears on your task bar.

Internet Explorer Help

Internet Explorer 4.01 includes a new Help facility, called HTML Help. HTML Help will be used by many applications in the future, and may gradually replace the standard Windows Help. This holds great promise for people with disabilities. Because Help is now displayed as Web pages, most of the accessibility features in Internet Explorer 4.01 are now also available when viewing Help topics. You can override formatting options in the Help, display text instead of images, disable animation, and even apply your own style sheet in order to have great control over how Help is presented. When you adjust these and similar options in Internet Explorer 4.01 and then restart Help, your settings will automatically apply to all Help topics you view. (The specific options that are of particular interest to people with disabilities are described elsewhere in this document.)

Keyboard navigation of Internet Explorer 4.01 Help

You can use tab to navigate between buttons, links, or panes of Internet Explorer 4.01 Help.

When a Help topic contains links, use tab to move from link to link. Internet Explorer automatically scrolls the contents of the pane to keep links in view. Use enter to activate a selected link.

The Hide button on the Help toolbar can hide the leftmost pane used for Content, Index, and Search. When this has been done there is no way to navigate Help or display the leftmost pane with the keyboard.

Using the Help Contents

To display the topics in the Contents list:

1. The highlight indicates that the keyboard focus is on the first topic in the list, "Introducing the Web Browser".

2. Use the up and down arrow keys to move the selection in the Contents list.

· As you select parent topics, they will automatically open, indicated by the open book icon and the expanded list of child topics.

· As you leave the last child page of an opened topic for the next topic, the opened topic closes, collapsing the list and displaying a closed book icon..

· Pressing enter also opens and closes topics indicated by book icons.

3. When you have made your selection of an available topic (indicated by a page icon), press enter to display the information in the right-hand pane.

· Your topic is displayed in the pane on the right, and the keyboard focus moves to the help topic. The string you searched for is highlighted wherever it appears in the topic.

· Use the arrow keys to scroll the screen up and down or left and right.

· Press home or end to scroll the screen to the beginning or end of the topic.

· Use ctrl+f10 to display the shortcut menu for the topic.

4. To return to the Contents list, press alt+c.

5. Press alt+f4 to quit Help.




Help Contents tabbed page

Using the Help Index

To display a topic using the Index list:

1. Press alt+I to display the Index page.

The Index page consists of a text field where you can enter a term, and a list box showing all available index entries.

The keyboard focus is in the text box. The first time you use this page, the text box is empty.

1. Use the arrow keys to scroll up and down the list of all topics

If you use the arrow keys, the selected topics will appear in the text box as you scroll.

or
Type the topic in the text box.

If you type a topic, the display will scroll to display matching topics as you type.

1. Press enter or alt+d to display the selected topic.

Your topic is displayed in the pane on the right. The keyboard focus moves to the help topic.

Your topic is displayed in the pane on the right, and the keyboard focus moves to the help topic. The string you searched for is highlighted wherever it appears in the topic.

· Use the arrow keys to scroll the screen up and down or left and right.

· Press home or end to scroll the screen to the beginning or end of the topic.

· Use ctrl+f10 to display the shortcut menu for the topic.

1. Use alt+i to choose other topics, or alt+f4 to close Help.




Help Index tabbed page

Searching in Help

To search for a topic by keyword in Internet Explorer 4.01 Help:
1. Press alt+s.

The Search tabbed page comes to the foreground and the highlight indicates that the keyboard focus is in the keyword text box.

1. Enter the keyword you want.

2. Press enter or alt+l.

A list of topics pertaining to your keyword will appear in the Topic list box.

1. Press alt+t and then the down arrow key to move the keyboard focus to the first item in the Topic list box.

The keyboard focus does not appear in the list box immediately after pressing alt+t, it appears after using the down arrow key.

1. Use the up and down arrows to select a topic.

2. Press enter or alt+d to display the selected topic.

Your topic is displayed in the pane on the right, and the keyboard focus moves to the help topic. The string you searched for is highlighted wherever it appears in the topic.

· Use the arrow keys to scroll the screen up and down or left and right.

· Press home or end to scroll the screen to the beginning or end of the topic.

· Use ctrl+f10 to display the shortcut menu for the topic.

1. Use alt+t to choose another topic, or alt+k to begin another search

2. Use alt+f4 to quit Help.




Help Search tabbed page

NetMeeting

NetMeeting features overview

NetMeeting delivers a rich set of data conferencing features that allow users to communicate with text and graphics based on the International Telecommunications Union (ITU) T.120 standard for multipoint data conferencing. Multipoint means that two or more people can connect together to form a conference, where they can all interact. Some key advantages of the use of data conferencing to communicate are that there is no additional hardware that you need to purchase - you don't need a sound card, microphone, or speakers, and you don't need a video camera, - and it works well over a dial-up modem connection to the Internet. The data conferencing tools that NetMeeting offers include the following, each of which is described in more detail below:

· Text-Based Chat

· Electronic whiteboard

· Native Application Sharing, allowing users to share applications running on one computer with others in a conference for real-time collaboration

· File Transfer

· Video Conferencing

The information in this section provides a brief overview of the data conferencing features of NetMeeting. More detailed information can be found on the Microsoft NetMeeting Web site, http://www.microsoft.com/netmeeting and in NetMeeting Help.

Text-Based Chat

The chat feature provides real-time text communication across the Internet, a corporate intranet, or a school network. With it, two or more users can gather together as part of a virtual meeting and send text messages to one another, allowing communication in real-time. The contents of a chat session can be saved as a transcript for easy review, editing or re-use. For an individual who is deaf or hard-of-hearing, the chat feature serves as the core means of communicating through NetMeeting. It can allow more flexibility and independence than a TTY because:

· It can transfer information at a greater speed.

· It allows simultaneous communication with multiple users.

· A NetMeeting user can interact with anyone who has access to a computer and modem, improving communications with others, whether or not they are deaf.

· Chat can be used in conjunction with the other features of NetMeeting to greatly expand the communication possibilities beyond the use of text alone.

Electronic Whiteboard

The electronic whiteboard capability in NetMeeting lets users share, draw, and annotate images with other people as part of a virtual meeting. Rather than communicating via text alone, the whiteboard can allow you to visually communicate about common topics and ideas. For example, you can show pre-existing drawings or pictures while chatting, and create ad hoc diagrams in real-time. It helps you get your ideas across when words alone are not enough.

Native Application Sharing and Collaboration

NetMeeting enables users to share a Windows-based application with other participants in a conference, allowing them to view the same application information on their screens. They can collaborate by making changes to shared information. For example, the native application-sharing feature of NetMeeting allows users to share a word processing application to collaboratively edit the same document at the same time. Traditionally, electronic mail has been used to send documents to different people to obtain changes. However, this process is very repetitive and often takes longer than working on the document simultaneously. Since virtually any Windows-based application can be shared for real-time collaboration, NetMeeting also serves as a valuable aid in situations such as distance learning and technical support.

File Transfer

NetMeeting provides a convenient method of sending files to other conference participants. During a conference, a user can send one or more files to all participants in the conference, or to a selected individual. For example, simply dragging and dropping the desired file into the NetMeeting window will send the file to all participants. This can be useful after making changes to a shared document using the native application-sharing feature. The final version can be sent to all conference participants before concluding the conference.

Video Conferencing

NetMeeting also offers video conferencing capability over the Internet or an intranet. If a camera is connected to your computer, the video conferencing feature allows another person in the conference to see you. You don't need a camera on your computer to see video that is sent by another user. The performance and quality of the video will vary depending on the speed of the PC, type of video camera, speed of the network connection, and amount of network traffic. You will probably find video performance inadequate for transmitting sign language over a dial-up modem connection, but you may find the performance reasonable over an intranet. Over a dial-up connection, you can still use the video capability to enhance your communications by being able to see the person you are communicating with. You can even copy a video image to the clipboard to paste into another Windows-based application (e.g., the Whiteboard in NetMeeting).

NetMeeting keyboard navigation and shortcuts

You can use shortcuts to navigate in NetMeeting and to place calls.

	To do this
	Press this

	Place a call
	ctrl+n

	Send a file
	ctrl+f

	Start the Whiteboard
	ctrl+w

	Start Chat
	ctrl+t

	Toggle among the Directory, SpeedDial, Current Call, and History lists
	ctrl+tab

	Refresh the Directory or SpeedDial list
	f5

	Stop loading the Directory list
	ctrl+l

	Open the folder list
	ctrl+d

	Toggle between the Audio toolbar and the main window, and if open, the folder list
	f6

	Select check boxes (such as the microphone and speaker check boxes on the Audio toolbar)
	spacebar

	Take control of a shared application
	any key

	Stop the collaboration of a person you are sharing an application with
	esc

	When application sharing, toggle between open windows
	 alt+tab


Differences Between Internet Explorer 4.0 and 4.01

Not all accessibility features were completed when Internet Explorer 4.0 for Windows first shipped. Internet Explorer 4.01 for Windows contains significant accessibility enhancements to the features available in Internet Explorer 4.0 for Windows. If you have installed the earlier version of Internet Explorer, you may have experienced the following difficulties. In that case, install version 4.01. You will find version information about your current copy of Internet Explorer in the Help menu under the About option. Internet Explorer 4.01 has a version number 4.72 or higher.

The Internet Explorer 4.01 enhanced accessibility features have not been implemented in Internet Explorer 4.0 for Unix, Internet Explorer 4.0 for Macintosh and Internet Explorer 4.0 for Windows 3.1.

For more detailed discussion of using Internet Explorer 4.0, see the reference guide available online at http://microsoft.com/enable.

Version 4.0 Potential problems for users with low vision

The following problems in Internet Explorer version 4.0 have been fixed in version 4.01:

· Some existing screen magnification utilities may not track the keyboard focus correctly, and so may not display items as they are selected with the keyboard.

· Internet Explorer 4.0 does not support the largest fonts that were available in version 3.0 when the High Contrast option was turned on in Control Panel. The same result can be achieved using custom style sheets, and a selection of such style sheets are available on the Web. However, we do not recommend users attempt to create their own style sheets in Internet Explorer 4.0.

· Users may have greater difficulty reading the descriptions of images when the images are not displayed. Internet Explorer 3.0 allowed the user to choose to display the entire description, whereas version 4.0 may cut off portions of those descriptions.

Version 4.0 Potential problems for users who are blind

The following problems in Internet Explorer version 4.0 have been fixed in version 4.01:

· Internet Explorer version 4.0 does not fully support Microsoft Active Accessibility, the standard for ensuring compatibility with accessibility aids such as blind-access utilities.

· Internet Explorer 4.0 uses non-standard menus. Some blind-access utilities may incorrectly identify these as buttons rather than menus. If you choose the Windows Desktop Upgrade option when installing Internet Explorer 4.0, these menus will also be used in the Windows Explorer and when viewing folders.

· Internet Explorer 4.0 displays lists of check boxes that may not be described correctly to blind users. When the Windows Desktop Upgrade is installed, these lists will also appear in various sections of Control Panel.

· Some existing blind-access utilities do not track the keyboard focus correctly, and so may not read items as they are selected with the keyboard.

· Users who rely on the keyboard may have difficulty learning to use some features of the Active Desktop, an option provided by Internet Explorer 4.0.

Version 4.0 Potential problems for users who rely on the keyboard

The following problems in Internet Explorer version 4.0 have been fixed in version 4.01:

· Users who rely on the keyboard may have difficulty learning to use some features of the Active Desktop, an option provided by Internet Explorer 4.0. Most of this functionality is available through the keyboard, and additional documentation on these techniques will be available at this Web site in the near future. You may want to turn off Active Desktop through the Settings on the Start Menu.

· Users who rely on the keyboard may have difficulty learning to use some features of the Help system used by Internet Explorer 4.0. tab does not move between items in the Help pages and the keyboard focus for the Contents page is confusing

· When navigating to a page, Internet Explorer 4.0 always resets the keyboard focus to the beginning of that page. Internet Explorer 3.0 would allow the user to continue navigating from the point the destination of their last link, or from the last place they had visited on that page.

· Internet Explorer 4.0 allows you to navigate through links using the tab key, just as you did in version 3.0. However, version 4.0 will allow navigating to objects that are not currently visible on the screen. This may result in the keyboard focus appearing to “disappear” at times. Simply pressing the tab key additional times will usually bring it back into view.

Version 4.0 Potential problems for users who rely on speech recognition

The following problems in Internet Explorer version 4.0 have been fixed in version 4.01:

· Internet Explorer version 4.0 does not fully support Microsoft Active Accessibility, the standard for ensuring compatibility with accessibility aids such as speech recognition utilities.

Version 4.0 Potential problems for users with cognitive disabilities

The following problems in Internet Explorer version 4.0 have been fixed in version 4.01:

· Users may have greater difficulty reading the descriptions of images when the images are not displayed. Version 4.0 may cut off portions of those descriptions.

· Users who need to keep as many options as possible on the screen at one time, and who have many commands on their Start menu, may want to avoid using the Windows Desktop Update. This option replaces the Start menu with a scrolling menu, which limits the number of menu commands visible at one time to those that fit in a single column.

Version 4.0 Additional cautions for Internet Explorer

Caution  Use caution when experimenting with the Format documents using my style sheet option. Errors in style sheets can cause serious problems with Internet Explorer 4.0. Use only style sheets that have been created by professional designers. When trying out new style sheets, keep those style sheet files on a floppy disk that can be removed in case a problem occurs.

Additional Accessibility Resources

For more information about Microsoft products and accessibility, visit our Web page at http://microsoft.com/enable. This also includes information on how to design accessible Web pages, new PowerToys to make Internet Explorer even more accessible, sample style sheets top use with Internet Explorer 4.01, and reference documents for Internet Explorer 3.0 and Internet Explorer 4.0.

Microsoft Services for People Who Are Deaf or Hard-of-Hearing

If you are deaf or hard-of-hearing, complete access to Microsoft product and customer services is available through a text telephone (TTY/TDD) service.

Customer Service

You can contact Microsoft Sales Information Center on a text telephone by dialing (800) 892-5234 between 6:30 a.m. and 5:30 p.m. Pacific time.

Technical Assistance

For technical assistance in the United States, you can contact Microsoft Technical Support on a text telephone at (425) 635-4948 between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through Friday, excluding holidays. In Canada, dial (905) 568-9641 between 8:00 A.M. and 8:00 P.M. eastern time, Monday through Friday, excluding holidays. Microsoft support services are subject to the prices, terms, and conditions in place at the time the service is used.

Microsoft Documentation in Alternative Formats

In addition to the standard forms of documentation, many Microsoft products are also available in other formats to make them more accessible.

Many of the Internet Explorer version 4 documents are also available as online Help, online user’s guides, or on a CD that comes with the package.

If you have difficulty reading or handling printed documentation, you can obtain many Microsoft publications from Recording for the Blind & Dyslexic, Inc. Recording for the Blind & Dyslexic distributes these documents to registered, eligible members of their distribution service, either on audio cassettes or on floppy disks. The Recording for the Blind & Dyslexic collection contains more than 80,000 titles, including Microsoft product documentation and books from Microsoft Press. For information about eligibility and availability of Microsoft product documentation and books from Microsoft Press, contact Recording for the Blind & Dyslexic at the following address or phone numbers:

	Recording for the Blind & Dyslexic, Inc.
20 Roszel Road
Princeton, NJ 08540
	Phone:
Fax:
World Wide Web:
	(609) 452-0606
(609) 987-8116
http://www.rfbd.org/


You can also download many of these books from the Microsoft Web site at http://microsoft.com/enable/.

Getting More Accessibility Information

In addition to the features and resources already described in this chapter, other products, services, and resources are available from Microsoft and other organizations.

Microsoft Products and Services for People with Disabilities

For more information for people with disabilities, contact:

	Microsoft Sales Information Center 
One Microsoft Way
Redmond, WA 98052-6393
	World Wide Web:
Voice telephone:
Text telephone: 
	http://microsoft.com/enable/
(800) 426-9400
(800) 892-5234


Computer Products for People with Disabilities

Microsoft provides a catalog of accessibility aids that can be used with the Windows and Windows NT operating systems. For information on how to obtain this catalog, please see the previous section You can obtain this catalog from our Web site or by phone. Please see the section on Microsoft Products and Services for People with Disabilities, earlier in this chapter.

The Trace R&D Center at the University of Wisconsin-Madison publishes database of more than 18,000 products and other information for people with disabilities. The database is available on their site on the World Wide Web. The database is also available on a compact disc, titled CO-NET CD, that is issued twice a year.

The Trace R&D Center also publishes a book, titled Trace ResourceBook, that provides descriptions and photographs of about 2,000 products.

To obtain these directories, contact:

	Trace R&D Center
University of Wisconsin
S-151 Waisman Center
1500 Highland Avenue
Madison, WI 53705-2280
	World Wide Web:
Fax:

	http://trace.wisc.edu/
(608) 262-8848


Information and Referrals for People with Disabilities

Computers and other assistive devices can help persons with disabilities to overcome a variety of barriers. For general information and recommendations on how computers can help you with your specific needs, you should consult a trained evaluator. For information about locating programs or services in your area that may be able to help you, please contact :

	National Information System 
University of South Carolina
 Columbia, SC 29208
	Voice/text telephone:
Fax:
	(803) 777-1782
(803) 777-9557
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